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Before You Begin  

Welcome to the RISA-3D General Reference manual. Please read this topic prior to installing the program and pay particular 

attention to the License Agreement. If you agree to the terms of the license then read the Installation section and install the 

program. If you are a first time user of RISA-3D you should turn your attention to the User's Guide (a separate document) 

which is designed to get you up and running as fast as possible while still exposing you to the important features of the 

software. 

The User's Guide is designed to be read in two ways. If you are already familiar with structural modeling in general you can 

skip the supporting text and read only the underlined action items to quickly move through the tutorial. If you want more 

thorough explanations of the modeling process you may read all or some of the supporting text as you see fit. 

After you have gone through the User's Guide, use this General Reference for detailed information on any topic. The topics 

are arranged in alphabetical order and are thoroughly indexed. 

Overview 

RISA-3D is a general-purpose 3-dimensional analysis and design program. This program has been developed to make the 

definition, solution and modification of 3D structural models as fast and easy as possible. Analysis, up to and including 

calculation of maximum deflections and stresses, may be done on structures constructed of any material or combination of 

materials. Complete steel and wood design are also included in the program. 

RISA-3D has full graphical modeling capability. You can draw your model on the screen and also perform extensive 

graphical editing simultaneously in multiple views. To modify your model data directly, RISA-3D  employs a powerful, 

proprietary spreadsheet. All this combined with flexible data generation algorithms makes modeling very easy. Graphic 

display of the model along with applied loads, boundary conditions and much more, is always available. The model can be 

rapidly edited, solved, viewed, modified, re-solved, etc. The truly interactive nature of RISA-3D  is its primary strength. 

RISA-3D is also able to perform elaborate error checking as you define the model, and offers context sensitive help every 

step of the way. 

RISA-3D is an interactive program as opposed to a batch mode program. With a batch mode program, you would edit a text 

file in one program (typically called a pre-processor), and then solve it with another program, and then view the solution 

results in yet another program (typically called a post-processor). With RISA-3D, all model editing, model solution, and 

results browsing is accomplished through the same interface and with the same program. The interactive approach offers 

several unique advantages over batch mode which include; the ability to do real time error checking of your model data, the 

ability to do rapid model editing, solution, editing, and re-solution without jumping from one program to another, and the 

need for the user to learn only one program interface. 

You may access the features in RISA-3D by using the menu system, or the toolbars. The best way to learn RISA-3D is to go 

through the User's Guide. The advantage to this is that you are exposed to the tools RISA-3D provides AND the ways that 

you can take advantage of them. 

Hardware Requirements 

Minimum 

¶ Any Windows compatible computer with a Pentium 3 or better processor 

¶ Windows 2000\XP\Vista\Windows 7 

¶ 256 MB of RAM 

¶ 200 MB of hard disk space 

¶ Two or three button mouse 

¶ USB port (required for Stand-Alone version or the Network Host computer) 
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Recommended 

¶ Windows XP\Vista\Windows 7 

¶ As much extended RAM as possible 

¶ As much free disk space as possible 

¶ Two button mouse with wheel 

Note 

¶ The amount of space needed by RISA-3D  to solve a particular structural model depends on the size of the model. 

RISA-3D  has been written such that it will use as much RAM as is available. If this isn't enough, RISA-3Dn will 

start using HD space until enough memory is obtained to solve the problem. Of course, if RISA-3D is required to 

use HD space, the solution will be much slower. So, the more memory you have available, the better. In general, 

500 Megabytes (MB) of RAM is a good amount to solve most problems. However, if you will be regularly 

solving large problems, more memory will save you a lot of time in the long run. See Solving Large Models for 

more information. 

Program Limits 

100,000 Joints 

32,000 Members 

100,000 Plates 

100,000 Solids 

5,000 Section Sets 

500 Materials 

1,000 Custom Wood Species 

500 Diaphragms 

1,000 Basic Load Cases 

200,000 Loads 

500 Moving Loads 

5,000 Load Combinations 

500 Mode Shapes 

Demonstration Version: While you can open and solve a larger model, the largest model that can be saved to disk with the 

demonstration version is limited to 40 Joints, 40 Members, 40 Plates . 

License Agreement 

END-USER LICENSE AGREEMENT FOR RISA Technologies, LLC® SOFTWARE 

The RISA-3D software product (SOFTWARE PRODUCT) includes computer software, the associated media, any printed 

materials, and any electronic documentation. By installing, copying or otherwise using the SOFTWARE PRODUCT, you 

agree to be bound by the terms of this agreement. If you do not agree with the terms of this agreement RISA Technologies, 

LLC is unwilling to license the SOFTWARE PRODUCT to you. In such event you must delete any installations and destroy 

any copies of the SOFTWARE PRODUCT and return the SOFTWARE PRODUCT to RISA Technologies, LLC within 60 

days of purchase for a full refund. 
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Copyright 2010 by RISA Technologies, LLC. All rights reserved. The SOFTWARE PRODUCT is protected by United 

States copyright laws and various international treaties. All rights not specifically granted under this agreement are reserved 

by RISA TECHNOLOGIES. 

1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and remains 

vested in RISA Technologies, LLC.  You may not rent, lease, or lend the SOFTWARE PRODUCT. You are specifically 

granted a license to the use of this program on no more than one CPU at any given time. The Network Version of the 

SOFTWARE PRODUCT is licensed for simultaneous use on a certain maximum number of network stations that varies on a 

per license basis. As part of the license to use the SOFTWARE PRODUCT, the program user acknowledges the reading, 

understanding and acceptance of all terms of this agreement.  The SOFTWARE PRODUCT may not be reviewed, compared 

or evaluated in any manner in any publication without expressed written consent of RISA Technologies, LLC. You may not 

disassemble, decompile, reverse engineer or modify in any way the SOFTWARE PRODUCT. If the SOFTWARE 

PRODUCT was purchased at a discounted price for educational purposes it may in no event be used for professional design 

purposes. The terms of this license agreement are binding in perpetuity. 

2. DISCLAIMER.  We intend that the information contained in the SOFTWARE PRODUCT be accurate and reliable, but it 

is entirely the responsibility of the program user to verify the accuracy and applicability of any results obtained from the 

SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by professional engineers and architects who 

possess an understanding of structural mechanics. In no event will RISA Technologies, LLC or its officers be liable to 

anyone for any damages, including any lost profits, lost savings or lost data. In no event will RISA Technologies, LLC or its 

officers be liable for incidental, special, punitive or consequential damages or professional malpractice arising out of or in 

connection with the usage of the SOFTWARE PRODUCT, even if RISA Technologies, LLC or its officers have been 

advised of or should be aware of the possibility of such damages. RISA TECHNOLOGIES' entire liability shall be limited to 

the purchase price of the SOFTWARE PRODUCT. 

3. LIMITED WARRANTY.  RISA Technologies, LLC warrants that the SOFTWARE PRODUCT will operate but does not 

warrant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA Technologies sole obligation 

and your exclusive remedy under this warranty will be to receive software support from RISA Technologies via telephone, 

email or fax. RISA Technologies shall only be obligated to provide support for the most recent version of the SOFTWARE 

PRODUCT. If your version of the SOFTWARE PRODUCT is not the most recent version RISA Technologies shall have no 

obligation to provide support in any form. Except as stated above the SOFTWARE PRODUCT is provided without warranty, 

express or implied, including without limitation the implied warranties of merchantability and fitness for a particular purpose.  

4. PROTECTION DEVICE.   In the event the SOFTWARE PRODUCT requires the use of a PROTECTION DEVICE to 

operate, you are specifically prohibited from attempting to bypass the functionality of the PROTECTION DEVICE by any 

means. If the PROTECTION DEVICE becomes broken or inoperable it should be returned to RISA TECHNOLOGIES for a 

replacement. The replacement will not be provided if RISA TECHNOLOGIES can not affirm that the broken PROTECTION 

DEVICE was originally provided by RISA TECHNOLOGIES for use with the SOFTWARE PRODUCT. A lost or stolen 

PROTECTION DEVICE will not be replaced by RISA TECHNOLOGIES. 

5. TERMINATION.  RISA TECHNOLOGIES may terminate your right to use the SOFTWARE PRODUCT if you fail to 

comply with the terms and conditions of this agreement. In such event you must delete any installations and destroy any 

copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE PRODUCT to RISA Technologies. 

6. CHOICE OF LAW.   By entering into this Agreement in accordance with Paragraph 1, above, you have agreed to the 

exclusive jurisdiction of the State and Federal courts of the State of California, USA for resolution of any dispute you have 

relating to the SOFTWARE PRODUCT or related goods and services provided by RISA Technologies. All disputes therefore 

shall be resolved in accordance with the laws of the State of California, USA and all parties to this Agreement expressly 

agree to exclusive jurisdiction within the State of California, USA. No choice of law rules of any jurisdiction apply. 

"RISA" as applied to structural engineering software is a trademark of RISA Technologies. 

Maintenance 

Program maintenance provides all upgrades toRISA-3D , and discounts on new products. 

When your maintenance expires, you will be given the opportunity to continue program maintenance on an annual basis. You 

are under no obligation to continue program maintenance, of course, but if you decide to discontinue maintenance you will 

no longer receive RISA-3D program upgrades and technical support. 
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Complete program support is available to registered owners of RISA-3D and is included in the purchase price. This support is 

provided for the life of the program. See Technical Support for a list of your support options. 

The ñlife of the programò is defined as the time period for which that version of the program is the current version. In other 

words, whenever a new version of RISA-3D is released, the life of the previous version is considered to be ended. 

RISA Technologies will support only the current version of RISA-3D. 

Installation 

To install RISA-3D  please follow these instructions: 

1. Put the RISA-3D CD in your computer CD drive. 

2. If the CD starts automatically go to step 4. If the CD does not start after 10 seconds click the Windows Start button 

and select Run. 

3. In the Run dialog box type ñd:\launchò (where ñdò is the label of your CD drive) and then click the OK  button. 

4. Follow the on-screen instructions. 
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Application Interface  

The User's Guide (a separate document) contains a tutorial that leads you through the RISA-3D interface with an actual 

model. Consider going through the tutorial if you have not done so already, as it is the fastest way to learn the program. 

Although it requires some time up front, the tutorial will save you time and brainpower in the long run. 

The features that are available to you in RISA-3D may be accessed through the main menu, shortcut menus, toolbars and 

shortcut keystrokes. You may use any or all of these vehicles to interact with the software. The main menu has the advantage 

of containing all of the program options and features and may initially be the simplest to use, letting you learn just one 

system. The toolbars contain more common options and invoke with one click. The shortcut menus present options relevant 

to the task at hand. The shortcut keys provide a fast way to access features should you use the program often enough to make 

them familiar to you. All of these features are discussed in the sections below. There are many ways to access features and 

the method that you will use will simply be a matter of personal preference. The good news is that you have the options. 

The bar along the top of the screen is called the titlebar and contains the name of the file that is currently open. The three 

buttons  on the far right side of the title bar are used to control the main window. The left button will shrink the 

main application window to a button on the taskbar. The middle button will shrink or maximize the window on your screen. 

The right button will close the window, prompting you to save changes if necessary. You will also see these buttons in other 

windows and they have basically the same functions there as well. 

The actual work that you do will be in the main area on the screen, which is called the workspace. When you open a model 

view, a spreadsheet or a dialog it will be opened in the workspace and listed in the Window menu. You may have as many 

windows open as you like. 

Main Menu 

All of the program features may be accessed through the main menu system at the top of the screen beginning with File on 

the far left and ending with Help or possibly Director  on the far right. Clicking on each of these menus (listed below) will 

display sub-menus that contain options that you may choose from. You may also select the main menus by using the ALT 

key along with the underlined letter in the menu you wish to choose. You may then continue to use the keyboard to choose 

from the menu options. In addition, some of the menu options will have hot key combinations listed to the right of the option. 

These hot keys allow you to use the keyboard to access features without using the menu system. 

File Menu 

New will close the current file, prompting for saving if necessary, and will open a new file. 

Open will close the current file, prompting for saving if necessary, and will open an existing file. 

Save will save the current file, prompting for a name if necessary. 

Save As will save the current file, prompting for a name. 

Append will insert another RISA-3D model into the current model. 

Import will close the current file, prompting for saving if necessary, and will open an existing RISA-2D (R2D), DXF, or 

STD file. 

Export  will export the current file to a DXF, SDNF, or Pro-Steel exchange file. Also allows the export of connection forces 

to the Descon connection design program.. 

For more information on the interaction between RISA and other programs refer to Appendix E.  

Print will access RISA-3D printing options. 

Page Setup will present page setup options for printing. 

Recent Files The five most recent files will be listed at the bottom of the menu. Selecting one of these files will close the 

current file, prompting for saving if necessary, and will open the selected file. 

Exit will close RISA-3D, prompting for saving if necessary. 
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Edit Menu 

Undo will undo the last edit that was applied to the model whether it was made graphically or in the spreadsheets. You may 

continue to apply Undo to remove up to 100 model edits. 

Redo will reverse the last undo that was applied to the model. You may continue to apply Redo to remove up to 100 undo 

operations. 

Copy will copy the selected spreadsheet cells or model view from the active window to the clipboard. 

Paste will paste data from the clipboard to the spreadsheet cells. 

Insert Line will insert a new line in the spreadsheet beneath the current line. 

Delete Line will delete the current spreadsheet line. 

Repeat Line will insert a new line in the spreadsheet beneath the current line and copy the data from the current line. 

Mark All  Lines will select all of the lines in the spreadsheet. 

Unmark Lines will unmark any currently marked lines. 

Delete Marked Lines will delete the marked lines in the spreadsheet. 

Find will locate an item on the spreadsheet by its label. 

Sort will sort the column containing the active cell. 

Fill Block  will fill the marked block of cells with a valid entry. 

Math on Block allows you to add, subtract, multiply or divide the values in the marked block of cells. 

Global 

Global opens the Global Parameters for the model. 

Units 

Units opens the Units settings. 

View Menu 

New View will open a new model view window. 

Save or Recall Views allows you to save a view or recall a view that has previously been saved. 

Clone View makes a copy of the current view so you can modify one and maintain the other. 

Refresh All will refresh all of the windows that are open in the workspace. 

Select provides graphic select options that are also provided on the Selection Toolbar. 

Unselect provides graphic unselect options that are also provided on the Selection Toolbar. 

Save or Recall Selection States allows you to save a selection or recall a selection that has previously been saved. 

Zoom provides options for zooming in and out of the current model view. 

Rotate provides options to snap the model view to global planes or an isometric view. 

Plot Options opens the Plot Options. 

Render will turn rendering of the current model view on or off, depending on the current setting. 

Drawing Grid  will turn the display of the Drawing Grid on or off, depending on the current setting. 

Project Grid  will turn the display of the Project Grid on or off, depending on the current setting. 

Axes will turn the display of the global axes in the model view on or off, depending on the current setting. 
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Boundaries will turn the display of the boundary conditions on or off, depending on the current setting. 

Loads will turn the display of the model loads on or off, depending on the current setting. 

Joint Labels will turn the display of the joint labels on or off, depending on the current setting. A third setting is also 

available where the joints themselves are not shown at all. 

Member Labels will turn the display of the member labels on or off, depending on the current setting. However, if rendering 

is turned on, member labels will not be visible in the model view. 

Insert Menu 

The Insert Menu will help you insert new items into the model. Most of the options will provide a graphical method of 

insertion but some will open spreadsheets where appropriate. See Graphic Editing for specific information. 

Modify Menu 

The Modify Menu  will help you modify existing items in the model. Most of the options will provide a graphical method of 

modification but some will open spreadsheets where appropriate. The Delete Items Dialog may also be accessed via this 

menu. See Graphic Editing for specific information. 

Spreadsheets Menu 

The Spreadsheets Menu provides access to any of the input spreadsheets. See Spreadsheet Operations to learn how to work 

within the spreadsheets. 

Solve Menu 

Clicking on the Solve Menu will immediately begin a solution to the model. See Solution for more information. 

Results Menu 

The Results Menu provides access to any of the results spreadsheets. See Results Spreadsheets for more information. 

Tools Menu 

Relabel Joints assigns new labels to the joints in their current order in the Joint Coordinates spreadsheet. 

Relabel Members assigns new labels to the members in their current order in the Members spreadsheet. 

Relabel Plates assigns new labels to the plates in their current order in the Plates spreadsheet. 

Full Model Merge will merge the entire model.  See Model Merge for more information. 

Round off joint coordinates will round off the coordinates. 

Switch Vertical Axes allows you to switch your vertical axis while maintaining consistent member orientation. 

Detach RISA3D from RISAFloor allows you to take a RISA-3D model that is linked to RISAFloor and ñdetachò it so that 

you can open / edit it without first going through RISAFloor.   

Preferences contain settings that let you customize the program. See Customizing RISA for more information. 

Reset All Program Defaults will reset all customized settings to the original factory settings. 

Window Menu 

In order to help you work with the model and the results, you are provided with many window arrangements to choose from. 

You may access them from the Window Menu. The best way to understand just what these 'tilings' do is to try them. 

Remember that once you choose a tiling you may adjust any of the windows as you wish. You may also use the Tile  

  button on the RISA Toolbar to access a list of tilings. 
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Help Menu 

Help Topics opens the RISA-3D Help File so that you may search the contents and the index. See Help Options to learn 

about getting help. 

Check for Updates runs an internal check for possible program updates. If your program is up to date, you will receive a 

message saying you are up to date. If you are out of date, the check will offer you the option to email RISA Technologies for 

upgrade information if you are out of date for a major update. If you are out of date just a minor update, then we will send 

you to our website to upgrade.. This check is also offered during the installation process. 

About provides RISA-3D version and hardware key information. 

Director Menu 

 

If you are working from within the RISA Building System (RBS), use this menu to switch between RISAFloor, RISA-3D 

and RISAFoundation. If you are not working within the RISA Building System, the Director Menu will not be shown. 

The directory button is located at the far, far right hand side of the Main Menu Toolbar as shown in the image above. 

Shortcut Menu 

The Shortcut Menu is also referred to as the Right-Click Menu . This is because to access the shortcut menu you simply 

click the RIGHT mouse button where you are working to see options that are relevant to what you are doing. For example if 

you are working in a model view the right click menu will provide options to help you modify the view and edit the model 

graphically. If you are working in a spreadsheet the menu will provide editing tools for that spreadsheet. 

This menu will appear wherever you RIGHT click the mouse. This way you do not need to move away from where you are 

working to select the features you want to use. 

Toolbars 

The Toolbars provide buttons to help you access common commands and popular options in the menu system discussed 

above. There are different toolbars that will appear as you work to build your model and browse your results. If at any time 

you are not sure what a particular button does, simply let your mouse hover over the button and a helpful tip will pop up and 

explain the button. 

RISA Toolbar 

 

The first horizontal toolbar located just below the Main Menu is called the RISA Toolbar. The buttons on this bar facilitate 

file and window access. You may use these buttons to open files and windows and also to analyze the model. 

Window Toolbar 

 

 

The Window Toolbar  is the second horizontal toolbar located below the Main Menu. It gets its name because the buttons 

change as you move from window to window in order to help you with what you are currently doing. When you are working 

in a model view the buttons provide viewing tools, such as Rotate and Zoom, to assist you with that view. There are also 

many other results and information display toggles, including some icons with the drop down arrow next to them. Clicking 

the arrow will show you the different view options for that icon. Clicking the icon itself will bring you back to the default 

view. Note that this model view toolbar is now fully customizable. See below for more information. 
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Other model view windows that are open will not be affected so that each may show different information. When you are 

working in a spreadsheet, editing tools are provided that are appropriate to that particular spreadsheet. Note that not all tools 

are available with all spreadsheets. In fact there are many tools that are provided for one spreadsheet only. See Spreadsheet 

Operations for more information. 

Customizable Model View Toolbar 

The model view toolbar is fully customizable. By creating your personalized toolbar, you can quickly access your most 

frequently used buttons. This can be done quickly and easily in just a few steps. 

1. Go to Tools menu and select Customize Toolbar. 

  

 

2. Select one of the toolbars by clicking in the box Available toolbar buttons, and click on Add to place them on the 

current toolbar. 

 

3. Once youôve moved the buttons to the Current Toolbar, you can rearrange them by clicking on Move Up or Move 
Down. 
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4. Click Close and you will see your selections on the model view toolbar. 

Note: 

¶ You must have a model view as the current view to see this toolbar. 

¶ If you add more buttons than will fit on the toolbar the buttons that are at the end of the "Current toolbar buttons" will 

be cut off. 

¶ The changes you have made will automatically be saved on a per-user (Windows User) basis, such that next time you 

open the program the toolbar will be arranged per your preferences. 

Selection Toolbar 

The vertical toolbar on the left side of the screen is the Selection Toolbar. This toolbar will only be available when the active 

window is a model view. The buttons on this toolbar help you select and unselect items in the model in order to help you 

build and modify the model or view results. See Graphic Selection for more information. 

 

Drawing Toolbar 

 

Another toolbar that is available is the Drawing Toolbar. Unlike those mentioned above, this toolbar is located in the model 

view windows rather than in the main application window. This way the drawing tools stay close to where you are working. 
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This toolbar controls modeling features that help you draw, load, and modify your model graphically. You may have more 

than one view open and a Drawing Toolbar for each view. This way you can simultaneously draw plates in one window and 

members in another. 

The Drawing Toolbar  may be displayed in any model view window by clicking  on the Window Toolbar  while in the 

model view window. Some of the buttons on the toolbar are for one-time applications such as modifying the drawing grid. 

Other buttons place you in an editing mode, such as Draw Members, that remains active until you cancel it. The current mode 

is indicated by the mouse pointer and by the state of the button. While in an editing mode the button will stay down until you 

click it again or choose another button. See Graphic Editing for more information. 

This brings us to an important point. Some of the toolbar buttons remain down when you press them to indicate that you are 

in a certain mode or that something is either on or off. For example the Box Zoom  button will stay down to indicate that 

you are currently in the zooming mode. The Show Drawing Toolbar  button will remain down when you turn on this 

toolbar for the active window. You may be in more than one mode at the same time as long as they are not mutually 

exclusive. 

 

The Data Entry Toolbar  is the vertical toolbar on the right side of the application window. It contains buttons that facilitate 

data entry through the spreadsheets. The buttons on this toolbar provide quick access to the spreadsheets that are also listed in 

the Spreadsheets Menu. You may open and close the toolbar by clicking the  button on the RISA Toolbar. 

The Results Toolbar is the vertical toolbar on the right side of the application window that is placed over the Data Entry 

Toolbar after the model has been solved. The buttons on this toolbar provide quick access to the results spreadsheets that are 

also listed in the Results Menu. You may open and close the toolbar by clicking the    button on the RISA Toolbar. 

Dynamic View Controls 

When your current window is a graphical model view, you can use the mouse wheel to dynamically zoom, pan, or rotate the 

graphical image. These functions are only available to users who have a mouse with a wheel button and whose computers are 

running the Windows XP operating system. 

Mouse Action Model View Function 

Rolling the Wheel 

Forward 

Zoom In 

Rolling the Wheel 

Backward 

Zoom Out 

Clicking and holding the 

Wheel Button 

Grab the image and pan in the direction of 

mouse movement 
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Click and hold the Wheel 

button while pressing the 

Shift key 

Dynamically rotate the structure in the 

direction of mouse movement 

  

Dynamic Pan: Clicking and holding the mouse wheel button triggers the tool and allows the user to pan or drag the view to 

the limit of scroll bars. 

Dynamic Zoom: This tool uses the wheel button on the mouse. Rotating forward zooms in and rotating backward zooms out. 

Dynamic Rotate: This tool is triggered by clicking and holding the mouse wheel button while holding the Shift key. The 

rotational movement will be based on the how the user drags the mouse cursor over the screen and the projection of global 

axis on the screen. For rotation about X axis, drag the cursor perpendicular to the projection of the global X axis. The same 

logic applies for Y or Z axis rotations. When rotation is initiated, the system locks for rotation about that axis until the user 

releases the middle mouse button. 

Zoom Previous/Next: Function keys F3 and F4 are associated with Zoom Previous and Zoom Next respectively. The system 

holds a doubly linked list of zoom info. This list has 10 zoom-states in the list. The F3 or F4 keystroke moves the active 

pointer forward or backward on the list. Each window has its own zoom list. 

Dynamic Distance Tool: This tool triggers by pressing the F5 key. The user has to pick up two points on the screen and the 

system gives back the total and partial distance between points on the status bar. 

Shortcut Keys and Hot Keys 

Shortcut Keys and Hot Keys allow you to use the keyboard to quickly access features. The difference between the two is 

simply that the shortcut keys are related to a specific window and will only work in that window while the hot keys will 

perform at most any time. 

General Hot Keys 

Key Combination Function 

F1 Help on the active window 

F5 Activates the Dynamic Distance Tool 

Ctrl-F1 Main Help topics 

Ctrl-F2 Create New view 

F7, Ctrl-F7 Opens solution choices 

Ctrl-Alt -F7 Replace shapes with suggested shapes and 

re-solve the model 

Ctrl-C Copy to the clipboard 

Ctrl-V Paste from clipboard 

Ctrl-N Start a new file 

Ctrl-O Open an existing file 

Ctrl-S Save the current file 

Ctrl-P Print 

Ctrl-Z Undo 

Alt - Access the menus by combining the Alt 

key with the underlined letter in the menu 
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Shortcut Keys available for Specific Windows 

Key Combination Model View Window Spreadsheet 

Ctrl-D Open last graphic editing 

dialog 

Delete Marked Lines 

Ctrl-G Toggle Drawing Toolbar   

Ctrl-A Select All   

Ctrl-U Unselect all   

Ctrl-F   Block Fill 

Ctrl-M   Block Math 

Ctrl-I Invert Selection   

Ctrl-L Toggle Lock unselected Unmark lines 

Ctrl-Enter   Press cell    button 

F2 Open Plot Options Start/Stop Cell Edit 

F3 Zoom Previous Insert line 

F4 Zoom Next Delete Line 

F5 Initiates the "Distance" tool Find 

F8   Repeat Current Line 

F9   Sort 

+ Zoom In   

- Zoom Out   

!"#$ PgUp PgDwn Scrolling Scrolling 

  

Spreadsheet Hot Keys that open spreadsheets 

Key Combination Unsolved model Solved Model 

Ctrl-Alt -B Basic Load cases   

Ctrl-Alt -C Joint Coordinates Corner Forces 

Ctrl-Alt -D Distributed Loads Joint Displacements 

Ctrl-Alt -E Members ï Primary Data Member  

Ctrl-Alt -F   Member Forces  

Ctrl-Alt -G Global Parameters   

Ctrl-Alt -H Model Generation Suggested Shapes  

Ctrl-Alt -I Diaphragms Member Torsion 

Ctrl-Alt -L Load Combinations Plate Forces 

Ctrl-Alt -M Materials Material Take Off 

Ctrl-Alt -N Joint Loads Concrete Reinforcing 

Ctrl-Alt -O Boundary Conditions Mode Shapes 
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Ctrl-Alt -P Member Point Loads Plate Stresses 

Ctrl-Alt -Q   Frequencies 

Ctrl-Alt -R Design Rules Reactions 

Ctrl-Alt -S Section Sets Member Stresses  

Ctrl-Alt -T   Story Drift 

Ctrl-Alt -U   Design Results 

Ctrl-Alt -V Moving Loads   

Ctrl-Alt -X Surface Loads   

Ctrl-Alt -Y Dynamics Settings   

Ctrl-Alt -Z Area Loads   

Ctrl-Alt -4 Plates   

Status Bar 

 

The Status Bar passes useful information to you as you work. It is divided into four parts located along the very bottom of 

the main application window, just beneath the workspace. 

The left side of the status bar shows a solution flag to indicate the solved state of the model as follows:   

Solution Type Unsolved Solved 

Static   

Dynamic   

Response Spectra   

To the right of the solution flags there are three message boxes. 

The first and largest box lets you know what you are currently doing. If you are in a spreadsheet, this box will contain the 

explanation of the current cell. If you are working in a model view and select a graphic editing option, look to this box for 

information on how to use the feature. 

The second box is used to pass you units of the current spreadsheet cell. 

The third box indicates the coordinates of the mouse when a model view is active. The mouse coordinates that are displayed 

are the coordinates of the grid point or joint that is nearest to the mouse. 

Windows 

Modeling the structure will take place within model views and spreadsheets, each in their own window that may be moved 

around the workspace and sized as you wish. The ability to have multiple model views and multiple spreadsheets open at one 

time is a powerful feature. The options in the Window Menu are provided to help you manage these windows. 

These windows contain three buttons    in the upper right corner to help you minimize, maximize and close the 

window, respectively. There are also scroll boxes to help you view information that is outside of the window viewing area. 

Click the scroll bar buttons or drag the scroll box to advance the display in one direction or another. 

Model Views 

Model View windows show a graphic view of the model. Open a new view with the    button. 
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You may open as many model view windows as you like. This is especially helpful when working in close on large models. 

You might have one overall view and a few views zoomed in and rotated to where you are currently working. You may also 

have different information plotted in multiple views. 

One thing to remember is that the toolbars that are displayed depends upon what window is active. The active window is the 

one with the blue titlebar. For example, if you are looking for the zoom toolbar button and the active window is a spreadsheet 

you need to select a model view first before you can access the zooming tools. 

Spreadsheets 

Spreadsheet windows are made up of rows and columns of data cells. If you wish to add or edit data in a spreadsheet cell 

you click on the cell, making it the active cell, and then edit the cell. This active cell is simply the green cell that moves 

around the spreadsheet as you hit the cursor keys (Ŷ , Ÿ), Page Up, Page Down, Home, End, etc. There is always one and 

only one active cell, which is the cell that has the ñattentionò of the keyboard. 

You may also select blocks of data to work on. You can select a block of data by clicking and holding the mouse button on 

the first cell in the block and then dragging the mouse to the opposite corner of the block and releasing the mouse. 

Dialogs 

A Dialog is a third type of window and is used to access a specific function within the program. Another powerful feature is 

that most of the dialogs may be left open while you edit the model, making it easy to make adjustments as you work. You 

will find that dialogs are very easy to work with. There are Help buttons that will bring you directly to the relevant topic in 

the help file. You may also click on the    button in the titlebar, and then click on any item in the dialog to get help for that 

item. 

Window Tiling 

Standard window tilings help you set up your workspace. Select the Tile    button and then select a tiling or choose 

them from the Window Special Tiling menu. 

The standard tilings include arrangements of spreadsheets and model view windows for creation of models and viewing 

results. Each of these groups have arrangements for working with joints, members, and plates and also loads. The best way to 

learn what these tilings do is to try them. 

Modes 

 There are three basic program modes (View, Select, and Edit ) and a mode hierarchy to allow you to move between them 

easily. While you are editing the model you may select items to edit. When you are finished selecting you will be returned to 

editing. Likewise, while you are selecting items you can adjust the view and then be returned to selecting. 

Different mouse cursors are used with each mode to make it clear what the current mode is. 

View Mode is the upper level mode that allows you to adjust the view by zooming in and out, rotating and setting plot 

options. This mode supersedes all other modes so that you may do these things at any time, and then be returned to the 

previous mode. This mode does not cancel other modes so that when you are finished adjusting the view you are returned to 

what you were doing. See Graphic Display for more information. 

Select Mode is the middle level mode that allows you to make a graphic selection of joints, members and plates.  This mode 

supersedes the Edit Mode but not the View Mode. This means that you can make a selection while in the middle of editing 

the view and when you are finished you are returned to the editing feature that you were using. It also means that you may 

adjust the view while remaining in the same Select Mode. See Graphic Selection for more information. 

Edit Mode is the lower level mode that allows you to graphically edit the model. You may make selections and adjust the 

view while in the edit mode such that when you are finished selecting you will be returned to the Edit Mode.  Some Edit 

Mode features have options on how you apply the edit. See Graphic Editing for more information. 

Note 
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¶ The default mode is the mode you are in if you are not in any other mode and is indicated by the standard 

 mouse cursor. The default mode is a selection mode where you can select/unselect individual items by clicking 

on them. You may also double-click on an item to view information about the item. 

¶ You may use the ESC key or the right mouse button to cancel a mode. 
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Boundary Conditions  

Boundary Conditions define how the model is externally constrained. All models must be attached to some external point or 

points of support. You may define these points of support as completely restrained or as partially restrained with a Spring. 

You can also define a spring support that has stiffness in only one direction with tension-only or compression-only springs. 

Creating and Modifying 

There are a number of ways to create or modify boundary conditions. You may view and edit the data in the Boundary 

Conditions Spreadsheet, you may double-click a joint to view and edit its properties, or you can use the Modify 

Boundaries tool to graphically assign or modify a possibly large selection of boundary conditions. 

Modify Boundary Conditions for Joints 

The graphical Modify Boundary  tool discussed here lets you specify and modify boundary conditions graphically. To use 

this, you will typically specify the new boundary condition, then select the joints that you want to assign or modify.  

You can modify or assign joints one at a time by selecting the Apply by Clicking/Boxing  option and then click on the joints 

you wish to modify. You may also modify or assign entire selections of joints by selecting the joints first and then use the 

Apply to All Selected option. 

The parameters shown are the same as those on the Boundary Conditions Spreadsheet and are described in Boundary 

Condition Options. Use the arrow buttons to select the boundary condition. For help on an item, click  and then click the 

item. 

 

The Use? check boxes next to the data fields indicate whether the particular parameter will be used or not when the 

modification is applied. If the box next to a field is checked, that parameter will be applied to any selected joints. If the box is 

NOT checked, the parameter will NOT be applied, even if a value is entered in the field. This lets you easily change one or 

two parameters on joints without affecting all the rest of the parameters. 

To Apply Boundary Conditions 

1. If there is not a model view already open then click  on the RISA Toolbar  to open a new view and click  to 

turn on the Drawing Toolbar  if it is not already displayed. 
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2. Click the  button and define the boundary condition. Check the Use? Box for the items to apply. For help on an 

item, click  and then click the item. 

3. You may apply the boundary condition by choosing joints on the fly or apply it to a selection of joints. 

To choose joints on the fly, choose Apply Entries by Clicking/Boxing Joints and click Apply . Click/Box the joints 

with the left mouse button. 

To apply the boundary condition to a selection of joints, choose Apply Entries to All Selected Joints and click 

Apply . 

Note 

¶ To apply more boundaries with different conditions, press CTRL-D to recall the Boundary Conditions Dialog. 

¶ You may also view and edit boundary conditions by double-clicking on a joint. 

¶ You may also specify or edit boundary conditions in the Boundary Conditions Spreadsheet. 

¶ To assign a Footing, you must have RISAFoot installed on the computer and you must first create a footing group 

in the Footing spreadsheet. 

¶ You may undo any mistakes by clicking the Undo  button. 

Generate Soil Springs 

A subgrade modulus may be automatically applied to horizontal plates in a model using the Subgrade Springs tool. The tool 

will generate compression-only springs in the vertical direction at all plate joints in the selected group of plates. Joints must 

be connected to plates which are perpendicular to the vertical direction or the joints will be ignored. If a boundary code other 

than a compression-only spring already exists in the vertical direction at that joint, the boundary code will NOT be modified. 

 

RISA-3D calculates the tributary area for each plate joint individually and multiplies that area by the subgrade modulus to 

determine the spring stiffness for the compression-only spring at that joint. The boundary codes for all plate joints affected 

are automatically modified in the Boundary Conditions Spreadsheet. 

Boundary Conditions Spreadsheet 

The Boundary Conditions Spreadsheet records the boundaries for the joints and may be accessed by selecting Boundary 

Conditions on the Spreadsheets Menu. 
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The Joint Label column contains the label of the joint that is restrained. The last column may contain the label for the spread 

footing that is assigned to the joint. The Footing column is only available if a current version of RISAFoot is also loaded on 

the computer. 

The remaining columns record the boundary conditions that apply to the joint. There are six degrees of freedom for each joint 

(3 translation, 3 rotation), so there are six columns for degrees of freedom. The last column records the footing group, if any, 

applied to the joint. Footings may only be used if RISAFoot is also loaded on the computer. The boundary conditions are 

entered in these remaining columns by selecting the cell, clicking  and choosing from the boundary options. You may also 

type them in directly. 

Boundary Condition Options 

Free joints have no restraint in any of the degrees of freedom and need not be listed on the Boundary Conditions 

Spreadsheet. The following are the valid boundary condition options that may be used for the six degrees of freedom. 

Note 

¶ Models that contain compression-only or tension-only springs must be iterated until the solution converges. 

Convergence is achieved when no more load reversals are detected in the springs. During the iteration process, 

each spring is checked, and if any springs are turned off (or back on), the stiffness matrix is rebuilt and model is 

resolved.  This can take quite a bit longer than a regular static solution. 

¶ You can enter the first letter of the option ("R" for Reaction, "S" for Spring, etc.) rather than typing out the entire 

code. RISA-3D fills in the rest automatically. The exceptions are the SLAVE and STORY entries, where the full 

word does have to be entered (since "S" denotes a spring). 

Boundary Condition at ALL Joints 

The entry "ALL" may be entered in the Joint Label field. The boundary conditions entered on this line will be applied to 

ALL t he joints not otherwise listed. This is useful if you should want to lock certain directions of movement for all or most of 

the joints. For example, if you are solving a 2D frame defined in the XY plane and you're only interested in the planar action, 

you could enter "ALL" and put an "F" (for Fixed) for Z translation, X Rotation and Y Rotation. See the following figure: 

 

Note 

¶ If a joint is explicitly listed with boundary conditions, those boundary conditions override the "ALL" conditions 

for all 6 directions. The "ALL" specified boundary codes apply only to those joints NOT otherwise listed on the 

Boundary Conditions Spreadsheet. This is why joints 1 and 2 in the figure above also have the Fixed code in 

the Z translation, 2x Rotation and 2y Rotation fields. 


















































































































































































































































































































































































































































































































































































































































































































































































































































































































































































